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Introduction
What is WinPhone

Welcome to WinPhone! The newest member of the ProPhone family, WinPhone allows
you to access the National Telephone Directory Databases on CD-ROM via windows. 
Now you need only click on the WinPhone icon from your program manager to peruse 
business and residential listings from all over the United States and Canada. The 
software allows you to download the listings to another drive; import the listings into 
another application; print customized mailing labels or dial a highlighted number 
directly. The software for all databases allows for wild card searching, enabling  you to 
search for a word in a string of words.  The listings for all databases are updated on a 
quarterly basis. Each quarter, about 25% of the listings are updated with information 
from new telephone directories. 
The databases that are available with WinPhone are SelectPhone, DirectPhone, 
FreePhone and CanadaPhone. SelectPhone is a set of four CD's containing business and
residential listings from United States telephone directories. Business listings are 
categorized  using the Department of Labor's Standard Industrial Classification (SIC) 
index. Therefore, you are able to sort listings by business classification. All of the 
SelectPhone fields are optimized for fast searching. The first of our global product line, 
CanadaPhone, is a single CD, with both business and residential listings from 
Canadian telephone directories. The Canadian business listings are also categorized by 
SIC codes. FreePhone is a single CD composed of business listings from the AT&T 
800 Telephone directory. The search software for FreePhone is the same as SelectPhone
and CanadaPhone software. Business listings are also categorized by SIC codes. 
DirectPhone is a set of two CD's containing business and residential listings from 
United States telephone directories. The DirectPhone search software is different from 
the other databases software. The primary index for DirectPhone is the name field. You 
must initiate the search with a name, and then narrow the search using the other sort 
fields. The business listings in DirectPhone are not categorized by SIC codes.

If you have further questions regarding the databases available to use with either the 
Windows or DOS applications, please call the Pro CD, Inc. Customer Support 
Department at 617-631-7272. You may also fax your questions to 617-631-9299, or 
journey down the Infobahn to our BBS, 617-631-4646. We would love to hear from 
you!
 

 Installation
WinPhone Windows Install

How to Install WinPhone

1. Place the CD into the CD-ROM drive.

2. From the program manager, click File and choose Run. (You may also do this from 
the File Manager.)

3. When the dialog box appears, type X:WINSTALL. (Where X is the letter assigned to



your CD-ROM drive.)

 

4. Click OK. 

5. After a few seconds, the WinPhone install program will appear on the screen. You 
will be asked to specify the hard drive letter, and the directory you would like to have 
the program installed in. You will also be asked whether any necessary changes can be 
made to the autoexec.bat  so the program can be installed properly. If you are unsure as 
to what you should enter, choose the default selections. 

6. Once installed, you may access WinPhone by clicking on the icon in your program 
manager.

The WinPhone Listing

A directory listing can contain the following information: name (Last, First, MI), 
address (house number, directional, street name, street suffix), city, state, zip, 
telephone, SIC, business, year, and number of employees. The chart shown below 
describes what field information is available with each database, and whether the field 
is a primary field, limit field, restrictive field or information field. 

µ §
Please refer to the table below for a description of the abbreviations.

· P = Primary Search:  Optimized searching capabilities. This field can be used to do a 
lookup or restrictive type of search. Searching may be done on this field alone, or it 
may be combined with other primary or limit fields for a more defined search.

· L = Limit Search:  Not a primary search field. This field will allow you to limit a 
search by selecting certain limit criteria.

· Inf = Information:  Data provided for informational purposes only. This is not a search
field. The information will export with the listing when using ASCII and Fixed formats.

· Res = Restrictive:  These fields are used to narrow a search to a specific address: city, 
state, zip, area code or telephone number. The search must be initiated using the 
primary search field for this product, the limiting criteria may then be entered.

· NA = Not Applicable: This field is not available with this product.
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WinPhone Windows
Database Selection Window

When you first enter the software, or when you click on the "New Disc" button  , or 
when you select "Open Database" from the File menu, you will get a list of available 
databases. The software will search all hard disks and available drives to find all of the 
ProPhone databases. As in the DOS product, you may also access this window using the
F9 function key. Double click on the database that you want to view to open it.  
 µ §
In this case, there are seven available databases. Once you have opened a new database 
you will see the Main Display menu.

The Main Display Window
 After choosing a database and opening it, you will see the Main Display Window. This
is the principal work space in WinPhone, where all of the searches will be executed. 

 
· The fields used to enter data are called Data Entry Fields and are shown in yellow 

above. The Main Display window shown here is from SelectPhone. Please refer to The 
WinPhone Listing for a list of what fields are available in the other databases. 

· Depending on the size of your screen, you may need to adjust the field sizes in order to 
see the SIC, Year and # of Employees fields.

· There are four pull down menu's available in the Main Display window. These are 
located on the State field, the Telephone field, the SIC field, and the Business field. The
purpose of the pull down menu is to provide you with information that you may not 
have readily accessible. Information such as State abbreviations, SIC codes and Area 
codes. 

· The area shown in white is the Data Retrieval Field. Listings that meet your search 
criteria can be found here. To scroll through retrieved listings, use the page up/page 
down keys, the arrow keys, or if you prefer, you may also use the scroll bar.

The Tag Manager Window
The Tag Manager shows a listing of all tagged items found in the Main Display 
Window; tagged items appear in red.  This window looks identical to the Main Display 
Window with the exception that the fields are grayed out and can't be used to input 
information.  

 
The purpose of the Tag Manager is to create a temporary file of listings that you will 
want to print, export, or dial once you have completed all of the searches.
When you Tag a listing using the   option key, (or by double-clicking highlighted 
listings), the listing will automatically be stored in the Tag Manager. Tagged listings 
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will remain in the Tag Manager until you Untag them. Clearing tagged listings from 
your search screen will not effect tagged listings in the Tag Manager. You must be in 
the Tag Manager to clear listings from it. You can create any size file with any 
combination of listings, then print or download them all at once. Once you exit 
WinPhone however, the listings will not be saved in the Tag Manager. 

WinPhone Buttons, 
Fields and Menus
The WinPhone Toolbar
You can use the mouse to click on the various buttons found on the toolbar to perform 
the specified function.  

µ §

  New Disc
Click this button or select "Open Database" from the File menu, to search all available 
hard disks and CD ROM drives for all ProPhone databases.  As in the DOS version, you
may also press the F9 function key to switch databases, and F10 to exit the program 
altogether. A pop up window will display the available databases. Use the left mouse 
button to double-click on the database you wish to view.

µ §

  Clear the Current Search Screen
Click this button or select "Clear Search" from the Edit menu to clear the information 
you have entered into the Data Entry fields and the resulting listings from the Data 
Retrieval field.  

  Tag an Item on the List
Create your own file with only the listings you want using the Tag Feature.  Simply 
click this button or select "Tag" from the Edit menu to tag the currently highlighted 
item(s) in the Main Display Window.  Tagged item(s) turn red showing that they have 
been tagged and will be transferred to the Tag Manager, double-clicking on the listed 
item will also perform this function.  Standard windows keys for highlighting items are 
fully functional and can be used to highlight multiple items prior to using the tag 
feature.

  Untag an Item on the List
If you want to remove a name from the Tag Manager, don't despair! Names can easily 
be removed by clicking this button, or select "Untag" from the Edit menu to untag a 
tagged item (untagged items appear in black). Double clicking on the tagged item will 
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also perform this function.  Standard windows keys for highlighting items are fully 
functional and can be used to highlight multiple items prior to using the untag feature.

  Sort by Address
If you have just successfully completed a renovation for one of your customers on a 
street and would like to find the names and addresses of his neighbors as potential 
leads, then you will benefit from the neighbor search. Click this button or select 
"Address" from the Sort menu to sort the highlighted listing by address and display all 
of the "neighbors".  

  Sort by Telephone Number
Click this button or select "Phone" from the Sort menu to sort the highlighted listing by 
telephone number and display listings that have the same or adjacent telephone 
numbers.  

  Sort by Name
Click this button or select "Name" from the Sort menu to sort the highlighted listing by 
name and display all listings with the same or alphabetically adjacent names. If you are 
making use of the neighbor or telephone search options, the simplest way to return to 
name search is to click this button.

  Print the Search List
Click this button or select "Print" from the File menu to print the current listing that 
meets the search criterion.  The list will be printed to the current default printer. Your 
print format options are either Fixed format, or Mailing Label format.

µ §

  Export the Search List
Click this button or select "Export" from the File menu to export or download the 
listings you are examining .  When exporting, you have the option of formatting your 
listings in ASCII, Fixed, Galley or Label format. A pop up window will prompt you for 
a file name in which to place the data, it will also ask for the format in which the 
information should be exported and what drive to place the file. An already existing file
will appear in grey.

  Count
Click this button or select "Count" from the File menu to count the number of entries 
meeting the search criterion in the currently selected window (Tag, Main etc.).  A pop 
up window showing the total number of entries found in the current list will be 
displayed.

  Dial a Highlighted Number
Click this button or select "Dial" from the Search menu to display a pop up window 
with the name, address and phone number of the currently highlighted item. Whether 
you are in the Main Display window, or the Tag Manager, you must highlight listings to
be dialed. Once you have selected a number and the modem is initialized, click the 
"Dial" button to dial the number.  As in the DOS version, you may also access the 
phone dialer by pressing the F2 function key. Click on the buttons below to get a 
description of each button.  
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    Scroll Up
Click on this button to scroll up through the list of highlighted entries.

    Scroll Down
Click this button to scroll down through the list of highlighted entries.

    Untag 
Click on this button to untag a tagged item.

    Dial
Click on this button to dial the displayed number.

    Configure Modem
Before using the    dial feature you must first configure the software to recognize your 
modem.  Clicking on the configure modem button will display a Configuration 
Window. Specify the various parameters, then click OK.

 

µ §    Retrieve
Meet Max, our retriever. Type your search criteria, and click on Max with your mouse 
button. Max will retrieve all matching listings. For those of you non dog lovers out 
there, you may also press the enter key to initiate the search.

The WinPhone Data Entry Fields
 
To perform a search, you must first enter data to search in the data entry fields. All 
fields are either primary fields (optimized within ProPhone to allow for fast searches) or
Limit fields (filters the searches). Please refer to The WinPhone Listing for a list of 
field descriptions for the database that you are using. You may switch fields using 
either the mouse, or the Tab key. 

µ §
Name Field
Select this field with the mouse and enter the name for the search criterion. Whether 
you are searching for a specific person, or for everyone with a particular name, you can 
accomplish this using the name field as your primary search. There are a number of 
different ways to search in this field: You can type in only a last name, (or part of a last 
name). You can type in only a first name (remember to type a space before typing the 
first name to make use of the wild card search). You can type a last name and a first 
name (or a first initial).

Address Field
Select this field with the mouse and enter an address for the search criterion. Searching 
the address field is advisable if you are looking for everyone who lives on a particular 
street, or in the cases where you know only the address of your lead. The address 
includes street number, street name, suffix and directional. You may narrow your 
search to sort by a complete address. You may also do a search as broad as only a street
name. (Remember to type a space before the street name to make use of the wild card 
search.)
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City Field
Select this field with the mouse and enter a city for the search criterion. You can 
identify everyone who lives in a particular city.

State Field
Tab to the state field or use the mouse button to select this field. Using the keyboard, 
enter a state abbreviation. If you are not sure what an abbreviation is for a particular 
state, use the pull down menu. Click the arrow in the lower right hand corner of the 
state field for a listing of all the states and the corresponding abbreviations. Double-
click the state to choose it.

 

Zip Code Field
Select this field using the mouse and enter a zip code, or part of the zip code for the 
search criterion.

Phone Number Field
Select this field using the mouse and enter a phone number, or enter only an area code 
for a search criterion. If you do not know the area code, click the arrow in the lower 
right hand corner of the field for a listing of all states and the corresponding area codes. 
To select an area code, highlight it and double-click to automatically insert it into the 
phone field.

 

SIC (Standard Industrial Classification) Code field
Select this field using the mouse and enter an SIC code for a search criterion. Searching
by  SIC code will generate a listing of all companies in a related field. If you do not 
know the SIC codes, use the SIC pull down menu. Click the arrow located in the lower 
right hand corner of the field.  

 

Business Flag field
Use this field if you want to limit your search to only business listings (B), or only 
residential listings (R), or all possible matches (A). 
Select this field using the mouse and enter the limiting sort criterion.  Depending on the
screen resolution, you may need to minimize fields in order to see the Business field. If 
you are not sure what to enter as a limiter, click the arrow button found in the lower 
right hand portion of the field to get a listing of available inputs. Double-click the item 
to choose it.

µ §

Publication Year field
This field displays the date the information was published in the database.  This field is 
used for display purposes only. The information in this field will download along with 
the listing when you download in the ASCII format.
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Number of Employees field 
This field displays the approximate number of employees associated with many 
businesses.  This field is used for display purposes only.

List Box button
Clicking on this button displays a list window listing all currently available choices for 
the particular field.  Double-click with the mouse to select an item, or enter input using 
the keyboard.  Then press enter for the entry to take effect.  
This button is available on the State, Phone, SIC Code and Business fields.
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Pull Down Menus
Use the mouse to pull down menus then click on the command.  Most of the available 
commands can also be accessed via the tool bar.  

 
Exit
You may either choose exit from the File menu, or press the F10 function key to exit 
the application.

Change Font
Click this menu item to change the Main Display Window font.  

Cascade
The opened databases will be displayed in a cascaded format.
 

Tile
The opened databases will be displayed in tile format.
 

Arrange Icons
Double-Clicking on this menu item will arrange the icons.

Select Application
The bottom portion of the menu lists all opened windows. The currently selected one is 
checked.  If a database is opened it will be included in the list.  To switch windows 
click on the window you want to select.

 

Windows Control Buttons

  Control Menu Box
Double click on this button to exit the application. 
 
  Minimize Buttons
Click the minimize button to reduce a window to an icon.  Double-click the icon to 
restore the application to its original size.

  This is the course icon and it will be displayed when you minimize the application.

µ § This is the database icon and it is displayed when you minimize a database.  The 
icon will be the same for all databases with the text denoting the database name.
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µ § A minimized Tag Manager has this icon.

  Maximize Button
Click on the maximize button to enlarge a window to its maximum size.

  Restore button
Click on this button to restore the window to its original size.

How To...
Search

Search Basics

There are three types of searches: lookup, restrictive, and sorts. A lookup search is 
where you retrieve listings by entering information into a single field. A restrictive 
search is where you enter information into two or more fields. A sort (not available with
DirectPhone) is where you wish to retrieve listings related to the highlighted listing, 
such as listings with adjacent telephone numbers or addresses. 
When searching for a listing, it is very important to correctly enter the data that you are 
searching. The software will search for what you typed in. If you do not find the listing 
that you are searching for, try a different spelling. Keep in mind that misplaced spaces, 
misspelled names, and inaccurate punctuation marks will throw the search off. Be 
aware of abbreviations when searching. A city with a long name may be abbreviated in 
the database. You must enter the abbreviated name to search correctly .
A search is considered to have an implicit wild card on the end of it. For example, if 
you enter Roberts you will retrieve listings beginning with Roberts including Robertsen,
Robertson. In the name field, if you only want to retrieve Roberts (and not Robertson, 
etc), press the space bar after entering the name Roberts, only those listings will appear.

Search Specialties: Boolean Operators

The Boolean Operators enhance the search engine and allow you to either perform more
defined searches, or to broaden the search scope. There are three types of Boolean 
searches that define a search: Or ( | ), And (+), & Not ( ! ); and there are three operators 
that will broaden the search: ( *, ? and $ ). The former group of operators works on the 
whole field, and the latter group works like wild cards, and can be inserted at different 
points in the string of characters. 
You may use the Boolean Operators in the following fields: Name, City, State,  Zip, 
Phone and SIC. The maximum number of entries in a given field is five. It is important 
to note that the boolean searches can slow the search engine down. It is advisable to 
keep the number of entries in a field to a minimum.

Defining a Search

Search More Than One Criterion In a Field

The most frequently used boolean operator is the OR operator. OR is commonly used in
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SIC, zip, and phone fields to sort multiple criteria. Using the OR operator will display 
all listings that match either the first criterion OR the second criterion. There are two 
ways of indicating an OR operator:

.OR.  is an 'or' operator  and   |  is an 'or' operator 

( | ) is also called the Pipe Key. On some keyboards it is pictured as a straight up and 
down line; and on other keyboards it is shown as a broken up and down line µ §, and is 
located above the backslash key ( \ ). This would be the operator to use if you are 
searching for everybody in more than one zip code, or in more than one area code, or in
more than one SIC code.

·  For Example, if in the telephone field you type:

508|617 

The search will return a complete list of everyone who lives in either the 
508 or the 617 area code.

·  Another way of specifying this search is to enter:

 508. OR. 617 

The search will return a complete list of everyone who lives in either the 
508 area code or the 617 area code. (Please note there should be no spaces
between any of the characters.)

Match Multiple Limiting Criteria in a Field
The AND operator is most commonly used in the SIC field. Using the AND operator, 
means listings must meet this criterion AND that criterion. There are two ways of 
indicating the AND operator:

. AND.  is an 'and' operator and  +  is an 'and' operator

Customers would use this field if they want to find listings that match two (or more) 
criteria in a given field.

·  For example: If you are searching in the SIC field for everyone who is both a
Dentist AND a Surgeon, you would enter: 

8021. AND. 8011S
Your retrieval field will display all people who are listed as both Dentists 
AND Surgeons. (Please note there should be no spaces between any of the
characters.)

· You may also perform the search in the following way: 

8021+8011S
for a complete display of all those who are both Dentists and Surgeons.

Weed Listings Out of Your Search
The NOT operator is used most often in the phone and zip code fields. Using the NOT 
search will provide a list of everybody who meets the search criterion except those you 
have indicated that you do not want to find. There are two ways of indicating the NOT 
operator:

. NOT.  is a 'not' operator  and  !  is a 'not' operator

· For Example, you would like to retrieve all listings in California, except not 
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those in the 619 and 213 area codes. In the state field enter CA, and in the phone field 
you would type: 

.NOT. 904.NOT.213
Your display will then show all the listings in California except not those 
in the 213 or the 904 area codes.

· Another way to do the same search is to enter:

!904!213

Broaden a Search
If you are unsure how to spell a name, or if you want to conduct a wild card search, you
may insert boolean wild card operators in place of  letters or characters. Please note, use
of the boolean operator may slow the search engine.
* Matches zero or more characters. Using this operator indicates that you are not sure 
whether or not there are characters missing from a string.
· For example, St Paul could also be spelled, Saint Paul. You may not 
know which spelling to use for a complete list of everyone in St Paul. 
Rather than doing the search two times to retrieve all of the listings, you 
could type: S*t Paul to retrieve all St Paul listings as well as the Saint 
Paul listings.

? Matches zero or one character.  Using this operator indicates that you are unsure as to
whether or not there should be a letter in a particular position.
· For example, you do not know if Joe spells his last name Macdougal or McDougal. In 
the data entery field you would type: M?cdougal to retrieve a complete list of  all the 
Macdougal and McDougal listings. The additional letter would be inserted where 
applicable, and omitted where not appropriate.

$ Matches exactly one character. When you insert the $, you are indicating that there 
should be a character in that position, you are just not sure what that letter is.
For example, you would type: Jeffers$n to display names spelled: Jefferson and 
Jeffersen.

How to Search by Name

1. Open a database.

2. Either Tab to the name field, or click on it with the mouse.

3. Type in the information that you have to search. If you are certain as to how an 
individual or a company is listed in the telephone directory, you may enter that 
information. (Residential listing: Last name, First name, MI; For a Business Listing try:
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Company name, The)

4. Either click on the retrieve button with your mouse, or press enter. The software will 
find all records that match the information you entered in the name field.

5. If you are unsure as to how the listing may appear in the directory, enter as much of 
the information as you are certain about. 

· For example, you are trying to locate an old friend, Andrea 
Bolino. You know how she spells her last name, but are uncertain as to 
whether she is listed under A. Bolino, or Andrea Bolino, or her frequently 
used nickname Andy Bolino. In this case the information that you are 
certain about is A. Bolino. In the name field, you would type: Bolino A

· Click on the retrieve button, or press enter.
· All of the A Bolino's will appear in the data retrieval field, 

including: A Bolino, Alexander Bolino, Andrea Bolino, & Aretha Bolino, 
etc. You should then be able to discern which A Bolino is your friend.

6. The other way to retrieve listings that you are uncertain about is to make use of the 
boolean wild card operators.

7. Once you have entered the search criteria, click the retrieve button  or press enter.

8. You may then browse through the listings using the scroll bar, page up/page down 
keys, or the arrow keys.

How to Search by Address

1. Open a database.

2. Either tab to the address field, or click in the field with the mouse. (If you are 
searching by a street address, click in the Address field. If you are searching a city, 
click in the City field; if you are searching a state, click in the State field; if you are 
searching by a zip code click in the Zip field.) Address searching generally works faster
when you enter in a State in combination with part of a city name or address. 

3. If you are searching a street address, it is important to enter the data as it appears in 
the directory. 

· For example, you are searching a listing on 4500 S 14th St NE. If
you spell 
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out NE as Northeast, or if you spell out S as South, or if you spell out 14 
as fourteen, the listing will not be found, because in the database it is 
listed as 4500 S 14th St NE. Please refer to the table of abbreviations for a
complete list of abbreviations.
 
4. Click the retrieve button µ §, or press enter.

How to Restrict the Search

1. Open a database.

2. Either tab to or click on the primary search field for the database that you are using, 
enter the search criteria.

3. You can narrow the search using as many of the restrict or limit fields as you would 
like. Tab to the field, or click on it using the mouse, and type in the limiting criteria.

· For example, you have the DirectPhone Business database open. (In the 
DirectPhone database you must initiate the search on the name field). You
would like to search all of the Wendy's restaurants in the 212 area code. In
the name field you enter Wendy's. In the Telephone field you enter 212.
·   Press enter, or click on the retrieve button for a complete list of all the 
Wendy's restaurant in the 212 area code.
·   Another example: In this example you have the SelectPhone Southern 
Region database open. (In SelectPhone, you can initiate a search on any of
the primary fields.) You want to search all listings on Rt A1A in the 407 
area code. In the address field type A1A, in the telephone field type 407.
·   Press enter or click on Max for a complete list of all listings on Rt A1A
in the 407 area code.
4.   Click on Max .µ § (or press enter) to retrieve the listings.

How to Perform a Wild Card Search

1.   Open a database.

2.   Either tab to the field that you want to search on, or click in the field using the 
mouse. The Wild Card search feature is available on the name field and the address 
field. 

3.   To perform a wild card search, also referred to as a global search, enter an asterisk *
before entering the search criteria.
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4.   Type in the data you have to search. In the name field you can search first names, or
a portion of a name, or a word in a string.

·   For example, you can sort all listings that have the word hardware in 
them; you may search all listings that have the letter sequence: Att.; or 
you may also search everyone with the first name Broomhilda.

5.   To initiate the search, either click the retrieve button µ § ,or press enter.

Please refer to the special section on Boolean Operators for a complete explanation on 
all wild card searching options.

How to Jericho Search
You are now able to search multiple databases at one time with the Jericho Search. The 
key to performing a Jericho search, is to open the databases at the same time. When you
first enter the software, you will see a list of available databases. Highlight the 
databases that you want to search. You may highlight contiguous databases by clicking 
on the first one you would like to open, then drag the cursor to the next database you 
would like open; or if the databases that you would like to search are non-contiguous, 
highlight the first one, then hold the control key down and click on the other databases 
you would like to open. Make sure that you hold the control key down until you have 
highlighted all of the databases that you want open. Once you release the control key, 
you won't be able to include additional databases. 

Opening Contiguous Databases:

µ §

1.   Highlight the first database that you would like to include in the Jericho Search. Do 
not release the mouse button.

2.   Click and Drag. Without releasing the mouse button, drag the highlight bar to 
include all of the databases you would like to search.

3.   To open the selected databases, press shift enter.

Opening Non-Contiguous Databases:

 

1.   Highlight the first database that you would like to include in the Jericho Search.

2.   Press the control key, then highlight the second database that you would like to 
search.
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3.   Continue to hold the control key down, and highlight the third database that you 
would like to search. You may include as many databases in the Jericho search as your 
system can handle.

4.   To open the selected databases, you may either double click the highlighted entries, 
or press shift enter.

You will know whether or not you have opened the databases properly if the Jericho 
Search window appears on your screen in place of the Main Display window. (See 
diagram below.) You may carry out the same searches in the Jericho Search window as 
in the Main Display window.  Only now you will be searching across multiple 
databases for the listings. Please note, each additional database requires 2 mgb's of Ram
to run.
You may perform a Jericho search with any combination of available databases. Keep 
in mind, however, that different databases may have different searching capabilities. 
For example, if you have both a SelectPhone and a DirectPhone database open, 
WinPhone will use the DirectPhone software for the searches. You will not see any 
information in the SIC, Business, Year and # of employee fields, nor will you be able to
search on these fields.  This is because SelectPhone has all of the same search 
capabilities as DirectPhone, but DirectPhone does not have all of the same search 
capabilities as SelectPhone.

µ §
Locking & Unlocking Fields
A locked field will freeze any search criterion that was in the field when you locked it. 
Double-clicking on a field will alternatively lock/unlock that field (a locked field 
appears in red).  This function is especially useful when conducting repetitive searches. 
People frequently ask, "How can I limit my search to only business listings? I do not 
need the residential listings." The easiest way to do this, is to type a B in the Business 
field. Then lock that field, and you need not continually re-enter that information.
 
Spelling, Spaces & Punctuation
WinPhone will match all information entered into the input field(s), including spaces, 
punctuation marks, numbers and letters.  Entering data appropriately ensures that the 
proper listings will be retrieved.
If you are searching for a last name containing a punctuation mark or space, include 
them with your entry.  If you do not find what you are searching for, try modifying the 
search criteria.  

For example:  

In this example your first search did not yield the listings that you wanted. You
then changed the search criteria slightly, and found whom you were looking

for.

You first entered:   You then changed entry to:

 MC FARLANE MCFARLANE

O'CONNER OCONNER

GUNTHER-KELLEY GUNTHER KELLY
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Abbreviations
Street Directionals:
Here are some common street directional abbreviations:
E        East

W      West

S         South

N        North

NE      Northeast

NW    Northwest

SE       Southeast

SW     Southwest

Include the space between the directional and the street name. In some cases the 
directional appears before the street name:

1234   E   Main  St.

In these situations the directional needs to be included in the street field.  This provides 
an accurate display if performing a name search and using Street as a qualifier or using 
Address as the primary Sort. In other instances, directionals appear after the street 
name:

1234 Hanging Mountain RD NW

56   Main W

Although in these cases it is not necessary to include the directional with your entry, if 
the directional is not included, you may retrieve a listing for the correct street but with 
the wrong directional.

City Abbreviations:  
Some city names are abbreviated due to length. If you are having difficulty retrieving a 
listing when searching by city, here are some suggestions for determining the correct 
abbreviation: 
· If known, request a search by Zip Code and note the city abbreviation.

·  If you know the Area Code and/or telephone prefix for the city, request a search using
this information and note the city abbreviation.

·  A common way to abbreviate is to eliminate the vowels from the word. In these 
instances, you would search only the consonants. For example, Fellowship Church Rd is
abbreviated Fllwshp Chrh Rd. 

·  If you are completely stumped as to how a listing may be abbreviated, make use of 
the implicit wild card available on the end of each search field. Enter only the first part 
of the city name. The software will retrieve all listings that begin with that string of 
characters.
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More Information Screen
Click the right mouse button to get the following screen that contains additional 
information for the highlighted listing.  Pointing the mouse at a listing other than the 
highlighted listing will give you more information on that listing as well.

µ §

Pull Down Menu

What is a Pull Down Menu?

There are four Pull Down Menu's available in the Main Display Window (available 
with SelectPhone and FreePhone only). These are located on the State field, the 
Telephone field, the SIC field, and the Business field. The purpose of the Pull Down 
Menu is to provide you with information that you may not have readily accessible. 
Information such as State abbreviations, SIC codes and Area codes. You can access 
these menus by clicking on the arrow button in the lower left hand corner of the state, 
phone, sic and business fields.

How To Use the State Pull Down Menu

1.   Click the arrow button in the lower right hand corner of the field.

2.   The window shown below will pop up to your screen.

 

3.   Type the state name, or abbreviation, or part of the state name. Do not press enter, 
the software will search automatically. A complete list of all states that contain the 
letter sequence you entered will appear on the screen.

4.   Using your mouse, highlight the state that you want to search. 

5.   Press enter or double-click highlighted listing to return to the Main Display window
and automatically insert into the state field.

How to Use the Phone Pull Down Menu

1.   Click the arrow button in the lower right hand corner of the Phone field.
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2.   The window shown below will  pop up to your screen.

 

3.   Type the state name or part of the state name, or the state abbreviation at the 
prompt. Do not press enter, the software will search automatically.

4.   A complete list of all area codes in the state will appear in the lower window. Some 
states have multiple area codes. The area codes are identified by major city in that area 
code.

5.   Highlight the area code that you wish to search.

6.   Press enter, or double-click the highlighted listing to return to the main Display 
window and automatically insert the area code into the Phone field. 

How to Use the SIC Pull Down Menu

1.   If you do not know the SIC codes, use the SIC pull down menu. Click the arrow in 
the lower right hand corner of the SIC field.

2.   The window shown below will pop up to the screen.

 

3.   Once in the pull down window, type in a key word for the kind of business you 
would like to search. Do not press enter, the software will search automatically. A 
complete list of all SIC codes containing that word will appear in the window.

4.   Highlight the SIC code that best suits what you are searching by clicking on it. 

5.   Press enter, and the SIC code will automatically be inserted into the SIC code field. 
Double-clicking on the highlighted word will also serve the same function. If you do 
not find the SIC code from the key word you searched, try typing the root, or a different
variation of the word.

You may print a complete list of all SIC codes used in the database. There is a file on 
the CD entitled SIC.ASC. You may copy the file from the CD-ROM drive to the hard 
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drive and print it. 
·   At the CD-ROM drive letter type: Copy  SIC.ASC  X:\ (X refers to your hard drive 
letter).

·   At the hard drive prompt type: Print  SIC.ASC

·   The next line will read: Name of list device [print]: press return.

·   The file will start printing. The SIC file is about 45 pages.

How to Use the Business Flag field
Use this field if you want to limit your search to only business listings (B), or only 
residential listings (R), or all possible matches (A). 
Select this field using the mouse and enter the limiting sort criterion.  If you are not 
sure what to enter as a limiter, click the arrow button found in the lower right hand 
portion of the field to get a listing of available inputs. Double-click the item to choose 
it.

µ §

Size the Data Entry Fields

Double-clicking on the top half of the bar that separates the fields will alternatively 
minimize and maximize the field to the left of the bar (shown in yellow below). This 
can be especially useful if you are only interested in some of the fields and the display 
isn't large enough to accommodate all fields.  To return the field to its actual size, 
simply click on the minimized button and the fields will be maximized again (shown in 
yellow).  Placing the mouse on the bottom portion of the field (shown in green)allows 
you to move the cell boundaries (when the arrow changes to a double arrow press and 
hold down the left mouse button and drag the boundary to the new location). 

 

 

µ §

How to Minimize & Maximize Search Fields

1.   Click the top portion of  the field separating bar to minimize the cell to the left of 
the bar.

2.   Click the bar a second time to restore the field to the original size.

How to Adjust Field Width

1.   Click on the black bar separating the fields.
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2.   Drag the bar to the left to make the field smaller.

3.   Drag the bar to the right to make the field wider.

Information that has been truncated due to a shortened field is indicated by an ellipsis 
and can be viewed by making the field wider.
In SelectPhone, CanadaPhone and FreePhone, it may be necessary to make the cells 
smaller to view the SIC field, Number of Employees field, Business Indicator field, and
the Publication Year field. Tabbing to these fields will not make these fields visible on 
your screen.

Print

How to Print

µ §

1.   Click    or choose Print from the File menu.

2.   Indicate which items you want to print: Highlighted Entries, Tagged Entries, or All 
Matching Entries, by clicking in the appropriate circle with the mouse button.

3.   Choose the format you want your listings to print out in, either Fixed or Label.

4.   Click OK.

Print Setup
The printer will default to the system printer.

Export

How to Export

1.   Select which listings you would like to export (highlighted, tagged, or all matching 
entries) by clicking in the appropriate circle with the mouse.

2.   Highlight the format you want your listings to export in (ASCII, Fixed, Galley or 
Label). If you choose label, you will need to use the label editor.

3.   Click OK.

 

1.   Choose the drive that you would like to put the file in.

2.   Choose the file type, to add the appropriate extension.

3.   Choose the directory where you would like to keep the file.
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4.   Name the file, add the appropriate extension.

5.   Click OK.

6.   To append an already existing file, locate and highlight the file name in the 
directory, then click OK. The file name will appear in grey. This denotes that the file 
name has been used before.

Print & Export Format's

Display in Fixed Field Format

µ § Highlight "Fixed" from the Format menu to format the information in fixed field 
format. This is the default format.  When Exporting, a Fixed Format is when the total 
number of spaces allotted to a field will be exported with the listing. The data in the 
field will not justify to the left or right to eliminate the spaces. The following is an 
example:

TEST CORP 622 JOHN ST PEABODY MA 32803
(555) 555-5555

TEST & CAL CORP 652 MIDWAY DANVERS NH 56565
(555) 555-5555

Please note that when Printing in Fixed Format, what you see on the screen is what 
will print. If  a listing is truncated on your screen due to a sized field, the listing will 
also be truncated when it prints. Be sure that all the data that you want to print is visible
on your screen before you print.

Display in Galley Format

µ § Highlight "Galley" from the Format menu to format the information in Galley 
Format. Galley Format is when all items are separated by one and only one space.  The 
data in a field will justify to eliminate any excess space that has not been taken up by 
the listing. The following is an example:

TEST CORP 622 JOHN ST PEABODY MA 32803 (555) 555-5555
TEST & CAL CORP 652 MIDWAY DANVERS NH 56565 (555) 555-5555

Display in ASCII Text File Format

µ §  Highlight "ASCII" from Format menu to format the information in ASCII text file 
format.  ASCII format means that all fields are enclosed in quotes and then separated by
a comma. 

"TEST CORP","622 JOHN ST","PEABODY","MA","32803","(555) 555-5555"
"TEST & CAL CORP","652 MIDWAY","DANVERS","NH","56565","(555) 555-5555"

Display in Address Label Format

µ § Highlight "Label" in the WinPhone Printing window or select "Address" from the 
Format menu to format the information in address label format.  This format resembles 
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a standard envelope address label and can be used to print labels.

 

Label Editor

Where to Find the Label Editor

µ §
 

1.   To format labels, you must choose print or export from the Toolbar or File menu. 
Use the mouse to highlight Label from the format options.

2.   To view the Label Editor, click on the word Label in the lower left hand corner of 
the screen.

3.   The label editor will then be displayed. Use it to edit the label size and margins.

How to Use the Label Editor

The label editor allows you to choose what size and type of labels you want to use. 
Click in the field with your mouse to change the default format to fit your labels.

 

1.   Vertical Number: How many labels down.
2.   Horizontal Number: How many labels across.
3.   Top Margin: How much space there is between the top of the sheet of labels and the
first label.
4.   Left Margin: How much space is between the left edge of the sheet of labels and the
start of the label.
5.   Vertical Spacing: How much space is between the columns of labels.
6.   Horizontal Spacing: How much space is between the rows of labels.
7.   If you are not sure what parameters are right for youur label, review the package 
they came in.
8.   Adjust label parameters, then click OK.

Dial

How to Dial

1.   Highlight the listing to be dialed.

2.   Click   on the toolbar, or choose dial from the File menu.

3.   Click   to configure your modem.
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How to Configure Modem

 

1.   You must set the following options before dialing.

·   Local Area Code: Enter your local area code. This indicates to the software which 
dial string it should use.

·   Local Prefixes: Enter the local prefixes for your area. Doing so indicates to the 
software which dialing string should be used.

2.   You must verify that the following options have defaulted to the appropriate 
settings.

·   Comport: The comport will default to Com1. If your system is connected to a 
different Comport, make that change in this box.

·   Dial: The default is ATTD (tone dial). In most cases you will need only use the 
default ATTD. However, should you need to change to ATPD (pulse dial), make that 
change in this box.

3.   The following options have defaults. You should not need to make any changes.

·   Local Dial String: The default is #. Based on the information that you entered into 
the local area code and local prefix fields, this dial string will be used if the number you
are dialing is within your area code and prefix.

·   In Area Dial String: The default is: 1#. This string will be used if the number you are
dialing is within your area code, but not in one of the local prefixes.

·   Out Of Area Dial String: The default is 1A#. This string will be used if the number 
you are dialing is not within your area code (or prefix). 

4.   Click OK.

Count

How to Count

1.   Key in the search criterion.

2.   Click Max (our retriever) to initiate the search, or press Enter.
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3.   Once the search has been initiated,  press the Count button, or choose Count from 
the Search menu.

4.   A pop up window asking for you to indicate what entries you want to count will be 
displayed:

µ §

5.   Once you indicate what you actually want to count, click OK and WinPhone will 
count:

µ §

Tag Manager

How to Add Listings to the Tag Manager

1.   Listings are added to the Tag Manager from the Main Display Window.

2.   Highlight listing(s) that you want to add to the Tag Manager by clicking on them 
with the mouse.

3.   Using your mouse, click on the Tag button  . Or double-click the highlighted 
listings. A tagged listing appears in Red.

How to Remove Listings from the Tag Manager

1.   You must be in the Tag Manager window to remove a listing from the Tag 
Manager. Choose Tag Manager from the Window menu.

2.   Highlight the listing(s) that you want to remove from the tag Manager by clicking 
on them with your mouse.

3.   Using your mouse, click on the untag button  . Or double-click highlighted listings. 
An untagged listing appears in black.

When you Tag a listing using the   option key, (or by double-clicking highlighted 
listings), the listing will automatically be stored in the Tag Manager. Tagged listings 
will remain in the Tag Manager until you clear them. Clearing tagged listings from the 
Main Display window will not effect tagged listings in the Tag Manager. You must 
actually be in the Tag Manager to clear listings from it. You can create any size file 
with any combination of listings, then print or download them all at once. Once you 
exit the program, listings in the Tag Manager will not be saved when you re-enter the 
program.
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How to Copy

Copying Listings to the Clipboard

1.   Choose Copy from the Edit menu.

2.   The WinPhone Clipboard Copying dialog window will appear on the screen.

µ §

3.   Set the appropriate parameters. You may copy either Highlighted Entries, Tagged 
Entries, or All Matching Entries. You may copy in any of the available formats: ASCII,
Fixed, Galley or Label. 

                                                                   

4.   Once you have indicated what you want to copy, and chosen the format you want to
copy the listings in, click the OK button.

5.   The WinPhone Clipboard dialog box will indicate how many records were copied, 
and when the copy is completed.

µ §

6.   You may then import the listings from the clipboard into any windows
application.
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Glossary of Terms
Function Key
As in the DOS version of the software, you may dial, switch databases and exit the 
program using the function keys.
F2=Dial
F9=Switch Database
F10=Exit
ASCII
American National Standard Code for Information Interchange.  The standard code, 
using a coded character set consisting of 7-bit coded characters (8 bits including parity 
check), that is used for information interchange among data processing, data 
communication systems, and associated equipment.
Boolean Operator
Boolean Operators enhance the search engine and allow you to either perform more 
defined searches, or to broaden the search scope. 
CanadaPhone
Canadian white and yellow pages on disc. Listings may be retrieved by name, address 
(including portions of the address), city, state, zip code, telephone number or type of 
business. Highlighted listings may be sorted by name, address or telephone number.
CD ROM
High-capacity read-only memory in the form of an optically read compact disc. 
CD ROM DRIVE
An optical mechanical device which is used to read CD ROM's.

Contiguous
Contiguous databases will appear adjacent to each other on your screen. They are 
located directly next to each other.
Database
A collection of data with a given structure for accepting, storing, and providing, on 
demand, data for multiple users.

DirectPhone
One national residential disc. One national business disc. Listings may be retrieved by 
name.
Fixed
When exporting, a Fixed format will export the total number of spaces allotted to a field
with the listing. When printing, the Fixed format will print the same data that is visible 
on your screen. If a listing is truncated on the screen, it will be truncated when it prints.
FreePhone
AT&T's toll free listings on disc. Listings may be retrieved by name, city, state, zip 
code, telephone number or type of business. Highlighted listings may be sorted by 
name, address, or telephone number.
Galley
Galley format is when each each field is separated by one and only one space. The data 
in the field will justify to eliminate any excess space not taken up by the listing.
Global search
A search for all listings that contain a string of characters.  Name and Address fields 
only.
For example,

Type an asterisk *, then enter HOS within a list of all names will produce the following 
list.
AB Hospital
Hospital workers of America
United Hospital Workers of Mass.
Hard Disk
A disk drive that reads and writes data on rigid disks and can be attached to a computer.
Icon
A graphic symbol, displayed on a screen, that a user can point to with a device such as a
mouse in order to select a particular function or software application.
Information Field
Data provided for informational purposes only. This is not a search field.
Jericho Search
The ability to search multiple databases at one time.
Keyword
A keyword is a word in a business heading that identifies a particular type of business. 
Label
The listing will print in a standard envelope address label.
Limit
Not a primary search field. This field will allow you to limit a search by selecting 
certain limit criteria.
Limit Search Field
Not a primary search field. This field will allow you to limit a search by selecting 
certain limit criteria.
Maximize Button
The small button containing an up arrow at the right of the title bar.  Mouse users can 
click the Maximize button to enlarge a window to its maximum size.  Keyboard users 
can use the Maximize command on the Control menu.
Minimize
To reduce a window to an icon by using the minimize button (at the right of the title 
bar).
Minimize Button
The small button containing a down arrow at the right of the title bar.  Mouse users can 
click the minimize bar to reduce the window to an icon.
Mouse
In computer graphics, a hand held pointing device operated by moving it on a flat 
surface.  It contains buttons used for selecting items off a screen.
Narrow Search Field
These fields are used to narrow a search to a specific address: city, state, zip; area code 
or telephone number. The search must be initiated using the primary search field for 
this product, the limiting criteria may then be entered.
Non-Contiguous
Non-Contiguous databases will not be adjacent to each other. They are not touching.

Pipe Key
The boolean operator that works as an OR function. ( | ) is also called the Pipe Key. On 
some keyboards it is pictured as a straight up and down line; and on other keyboards it 
is shown as a broken up and down line µ §, and is located above the backslash key ( \ ).



Primary
Optimized searching capabilities. This field can be used to initiate a search. Searching 
may be done on this field alone, or it may be combined with other primary or limit 
fields for a more defined search.
Primary Search Field
Optimized searching capabilities. This field can be used to initiate a search. Searching 
may be done on this field alone, or it may be combined with other primary or limit 
fields for a more defined search.
Restrictive
A restrictive search is where you enter information into two or more fields for a more 
defined search.
Scroll Bar
A bar that appears at the right and/or bottom edge of a window or list box whose 
contents are not completely visible.  Each scroll bar contains two scroll arrows and a 
scroll box, which enable you to scroll through the contents of the window or list box.
SelectPhone
Four regional discs containing both business and residential listings. Listings may be 
retrieved by name, address (including portions of the address), city, state, zip code, 
telephone number or type of business. Highlighted listings may be sorted by name, 
address, or telephone number.
Toolbar
A graphical bar found at the top of the WinPhone user interface with buttons that 
perform most of the commands for WinPhone, such as tagging and untagging items 
from the list.
Wild Card Search
There is an implicit wild card at the end of each search field that will search all words 
that begin with a particular string of characters. By typing an asterisk * before entering 
the search criteria, you may then search those characters in a string of characters.
Window
A rectangular area on your screen in which you view an application.  You can open, 
close and move windows and change the size of most windows.  You can open several 
windows at a time, and you can often reduce a window to an icon or enlarge it to fill the
entire desktop.
Windows
The graphical user interface you are currently using to launch this help file.
WinPhone
WinPhone allows you to access the National Telephone Directory Databases on CD-
ROM via windows.
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	Introduction
	What is WinPhone

	Installation
	WinPhone Windows Install
	How to Install WinPhone
	1. Place the CD into the CD-ROM drive.
	2. From the program manager, click File and choose Run. (You may also do this from the File Manager.)
	3. When the dialog box appears, type X:WINSTALL. (Where X is the letter assigned to your CD-ROM drive.)
	4. Click OK.
	5. After a few seconds, the WinPhone install program will appear on the screen. You will be asked to specify the hard drive letter, and the directory you would like to have the program installed in. You will also be asked whether any necessary changes can be made to the autoexec.bat so the program can be installed properly. If you are unsure as to what you should enter, choose the default selections.
	6. Once installed, you may access WinPhone by clicking on the icon in your program manager.

	The WinPhone Listing
	· P = Primary Search: Optimized searching capabilities. This field can be used to do a lookup or restrictive type of search. Searching may be done on this field alone, or it may be combined with other primary or limit fields for a more defined search.
	· L = Limit Search: Not a primary search field. This field will allow you to limit a search by selecting certain limit criteria.
	· Inf = Information: Data provided for informational purposes only. This is not a search field. The information will export with the listing when using ASCII and Fixed formats.
	· Res = Restrictive: These fields are used to narrow a search to a specific address: city, state, zip, area code or telephone number. The search must be initiated using the primary search field for this product, the limiting criteria may then be entered.
	· NA = Not Applicable: This field is not available with this product.


	WinPhone Windows
	Database Selection Window
	The Main Display Window
	· The fields used to enter data are called Data Entry Fields and are shown in yellow above. The Main Display window shown here is from SelectPhone. Please refer to The WinPhone Listing for a list of what fields are available in the other databases.
	· Depending on the size of your screen, you may need to adjust the field sizes in order to see the SIC, Year and # of Employees fields.
	· There are four pull down menu's available in the Main Display window. These are located on the State field, the Telephone field, the SIC field, and the Business field. The purpose of the pull down menu is to provide you with information that you may not have readily accessible. Information such as State abbreviations, SIC codes and Area codes.
	· The area shown in white is the Data Retrieval Field. Listings that meet your search criteria can be found here. To scroll through retrieved listings, use the page up/page down keys, the arrow keys, or if you prefer, you may also use the scroll bar.

	The Tag Manager Window

	WinPhone Buttons, Fields and Menus
	The WinPhone Toolbar
	New Disc
	Clear the Current Search Screen
	Tag an Item on the List
	Untag an Item on the List
	Sort by Address
	Sort by Telephone Number
	Sort by Name
	Print the Search List
	Export the Search List
	Count
	Dial a Highlighted Number
	Scroll Up
	Scroll Down
	Untag
	Dial
	Configure Modem

	µ § Retrieve

	The WinPhone Data Entry Fields
	
	Name Field
	Address Field
	City Field
	State Field
	Zip Code Field
	Phone Number Field
	SIC (Standard Industrial Classification) Code field
	Business Flag field
	Publication Year field
	Number of Employees field
	List Box button

	Pull Down Menus
	Exit
	Change Font
	Cascade
	Tile
	Arrange Icons
	Select Application

	Windows Control Buttons
	Control Menu Box
	Minimize Buttons
	This is the course icon and it will be displayed when you minimize the application.
	µ § This is the database icon and it is displayed when you minimize a database. The icon will be the same for all databases with the text denoting the database name.
	µ § A minimized Tag Manager has this icon.
	Maximize Button
	Restore button


	How To...
	Search
	Search Basics
	Search Specialties: Boolean Operators
	Defining a Search
	Search More Than One Criterion In a Field

	.OR. is an 'or' operator and | is an 'or' operator
	· For Example, if in the telephone field you type:
	508|617

	The search will return a complete list of everyone who lives in either the 508 or the 617 area code.
	· Another way of specifying this search is to enter:
	508. OR. 617

	The search will return a complete list of everyone who lives in either the 508 area code or the 617 area code. (Please note there should be no spaces between any of the characters.)
	Match Multiple Limiting Criteria in a Field
	. AND. is an 'and' operator and + is an 'and' operator
	· For example: If you are searching in the SIC field for everyone who is both a Dentist AND a Surgeon, you would enter:

	Your retrieval field will display all people who are listed as both Dentists AND Surgeons. (Please note there should be no spaces between any of the characters.)
	· You may also perform the search in the following way:

	for a complete display of all those who are both Dentists and Surgeons.
	Weed Listings Out of Your Search
	. NOT. is a 'not' operator and ! is a 'not' operator
	· For Example, you would like to retrieve all listings in California, except not those in the 619 and 213 area codes. In the state field enter CA, and in the phone field you would type:

	.NOT. 904.NOT.213
	Your display will then show all the listings in California except not those in the 213 or the 904 area codes.
	· Another way to do the same search is to enter:
	Broaden a Search

	· For example, St Paul could also be spelled, Saint Paul. You may not know which spelling to use for a complete list of everyone in St Paul. Rather than doing the search two times to retrieve all of the listings, you could type: S*t Paul to retrieve all St Paul listings as well as the Saint Paul listings.
	· For example, you do not know if Joe spells his last name Macdougal or McDougal. In the data entery field you would type: M?cdougal to retrieve a complete list of all the Macdougal and McDougal listings. The additional letter would be inserted where applicable, and omitted where not appropriate.
	How to Search by Name
	1. Open a database.
	2. Either Tab to the name field, or click on it with the mouse.
	3. Type in the information that you have to search. If you are certain as to how an individual or a company is listed in the telephone directory, you may enter that information. (Residential listing: Last name, First name, MI; For a Business Listing try: Company name, The)
	4. Either click on the retrieve button with your mouse, or press enter. The software will find all records that match the information you entered in the name field.
	5. If you are unsure as to how the listing may appear in the directory, enter as much of the information as you are certain about.

	· For example, you are trying to locate an old friend, Andrea Bolino. You know how she spells her last name, but are uncertain as to whether she is listed under A. Bolino, or Andrea Bolino, or her frequently used nickname Andy Bolino. In this case the information that you are certain about is A. Bolino. In the name field, you would type: Bolino A
	· Click on the retrieve button, or press enter.
	· All of the A Bolino's will appear in the data retrieval field, including: A Bolino, Alexander Bolino, Andrea Bolino, & Aretha Bolino, etc. You should then be able to discern which A Bolino is your friend.
	6. The other way to retrieve listings that you are uncertain about is to make use of the boolean wild card operators.
	7. Once you have entered the search criteria, click the retrieve button or press enter.
	8. You may then browse through the listings using the scroll bar, page up/page down keys, or the arrow keys.
	How to Search by Address
	1. Open a database.
	2. Either tab to the address field, or click in the field with the mouse. (If you are searching by a street address, click in the Address field. If you are searching a city, click in the City field; if you are searching a state, click in the State field; if you are searching by a zip code click in the Zip field.) Address searching generally works faster when you enter in a State in combination with part of a city name or address.
	3. If you are searching a street address, it is important to enter the data as it appears in the directory.

	· For example, you are searching a listing on 4500 S 14th St NE. If you spell
	out NE as Northeast, or if you spell out S as South, or if you spell out 14 as fourteen, the listing will not be found, because in the database it is listed as 4500 S 14th St NE. Please refer to the table of abbreviations for a complete list of abbreviations.
	
	4. Click the retrieve button µ §, or press enter.
	How to Restrict the Search
	1. Open a database.
	2. Either tab to or click on the primary search field for the database that you are using, enter the search criteria.
	3. You can narrow the search using as many of the restrict or limit fields as you would like. Tab to the field, or click on it using the mouse, and type in the limiting criteria.

	· For example, you have the DirectPhone Business database open. (In the DirectPhone database you must initiate the search on the name field). You would like to search all of the Wendy's restaurants in the 212 area code. In the name field you enter Wendy's. In the Telephone field you enter 212.
	· Press enter, or click on the retrieve button for a complete list of all the Wendy's restaurant in the 212 area code.
	· Another example: In this example you have the SelectPhone Southern Region database open. (In SelectPhone, you can initiate a search on any of the primary fields.) You want to search all listings on Rt A1A in the 407 area code. In the address field type A1A, in the telephone field type 407.
	· Press enter or click on Max for a complete list of all listings on Rt A1A in the 407 area code.
	4. Click on Max .µ § (or press enter) to retrieve the listings.
	How to Perform a Wild Card Search
	1. Open a database.
	2. Either tab to the field that you want to search on, or click in the field using the mouse. The Wild Card search feature is available on the name field and the address field.
	3. To perform a wild card search, also referred to as a global search, enter an asterisk * before entering the search criteria.
	4. Type in the data you have to search. In the name field you can search first names, or a portion of a name, or a word in a string.

	· For example, you can sort all listings that have the word hardware in them; you may search all listings that have the letter sequence: Att.; or you may also search everyone with the first name Broomhilda.
	5. To initiate the search, either click the retrieve button µ § ,or press enter.
	How to Jericho Search
	1. Highlight the first database that you would like to include in the Jericho Search. Do not release the mouse button.
	2. Click and Drag. Without releasing the mouse button, drag the highlight bar to include all of the databases you would like to search.
	3. To open the selected databases, press shift enter.
	1. Highlight the first database that you would like to include in the Jericho Search.
	2. Press the control key, then highlight the second database that you would like to search.
	3. Continue to hold the control key down, and highlight the third database that you would like to search. You may include as many databases in the Jericho search as your system can handle.
	4. To open the selected databases, you may either double click the highlighted entries, or press shift enter.
	Locking & Unlocking Fields
	Spelling, Spaces & Punctuation
	For example:
	In this example your first search did not yield the listings that you wanted. You then changed the search criteria slightly, and found whom you were looking
	for.
	You first entered: You then changed entry to:
	MC FARLANE MCFARLANE
	O'CONNER	OCONNER
	GUNTHER-KELLEY GUNTHER KELLY
	A-1 COMPUTERS A 1 COMPUTERS
	J & L PET STORE J&L PET STORE
	Abbreviations
	E East
	W West
	S South
	N North
	NE Northeast
	NW Northwest
	SE Southeast
	SW Southwest
	1234 E Main St.
	1234 Hanging Mountain RD NW
	56 Main W
	· If known, request a search by Zip Code and note the city abbreviation.
	· If you know the Area Code and/or telephone prefix for the city, request a search using this information and note the city abbreviation.
	· A common way to abbreviate is to eliminate the vowels from the word. In these instances, you would search only the consonants. For example, Fellowship Church Rd is abbreviated Fllwshp Chrh Rd.
	· If you are completely stumped as to how a listing may be abbreviated, make use of the implicit wild card available on the end of each search field. Enter only the first part of the city name. The software will retrieve all listings that begin with that string of characters.

	More Information Screen
	µ §

	Pull Down Menu
	What is a Pull Down Menu?
	How To Use the State Pull Down Menu
	1. Click the arrow button in the lower right hand corner of the field.
	2. The window shown below will pop up to your screen.
	3. Type the state name, or abbreviation, or part of the state name. Do not press enter, the software will search automatically. A complete list of all states that contain the letter sequence you entered will appear on the screen.
	4. Using your mouse, highlight the state that you want to search.
	5. Press enter or double-click highlighted listing to return to the Main Display window and automatically insert into the state field.
	How to Use the Phone Pull Down Menu
	1. Click the arrow button in the lower right hand corner of the Phone field.
	2. The window shown below will pop up to your screen.
	3. Type the state name or part of the state name, or the state abbreviation at the prompt. Do not press enter, the software will search automatically.
	4. A complete list of all area codes in the state will appear in the lower window. Some states have multiple area codes. The area codes are identified by major city in that area code.
	5. Highlight the area code that you wish to search.
	6. Press enter, or double-click the highlighted listing to return to the main Display window and automatically insert the area code into the Phone field.
	How to Use the SIC Pull Down Menu
	1. If you do not know the SIC codes, use the SIC pull down menu. Click the arrow in the lower right hand corner of the SIC field.
	2. The window shown below will pop up to the screen.
	3. Once in the pull down window, type in a key word for the kind of business you would like to search. Do not press enter, the software will search automatically. A complete list of all SIC codes containing that word will appear in the window.
	4. Highlight the SIC code that best suits what you are searching by clicking on it.
	5. Press enter, and the SIC code will automatically be inserted into the SIC code field. Double-clicking on the highlighted word will also serve the same function. If you do not find the SIC code from the key word you searched, try typing the root, or a different variation of the word.
	· At the CD-ROM drive letter type: Copy SIC.ASC X: (X refers to your hard drive letter).
	· At the hard drive prompt type: Print SIC.ASC
	· The next line will read: Name of list device [print]: press return.
	· The file will start printing. The SIC file is about 45 pages.
	How to Use the Business Flag field
	µ §

	Size the Data Entry Fields
	How to Minimize & Maximize Search Fields
	1. Click the top portion of the field separating bar to minimize the cell to the left of the bar.
	2. Click the bar a second time to restore the field to the original size.
	How to Adjust Field Width
	1. Click on the black bar separating the fields.
	2. Drag the bar to the left to make the field smaller.
	3. Drag the bar to the right to make the field wider.

	Print
	How to Print
	1. Click or choose Print from the File menu.
	2. Indicate which items you want to print: Highlighted Entries, Tagged Entries, or All Matching Entries, by clicking in the appropriate circle with the mouse button.
	3. Choose the format you want your listings to print out in, either Fixed or Label.
	4. Click OK.
	Print Setup


	Export
	How to Export
	1. Select which listings you would like to export (highlighted, tagged, or all matching entries) by clicking in the appropriate circle with the mouse.
	2. Highlight the format you want your listings to export in (ASCII, Fixed, Galley or Label). If you choose label, you will need to use the label editor.
	3. Click OK.
	1. Choose the drive that you would like to put the file in.
	2. Choose the file type, to add the appropriate extension.
	3. Choose the directory where you would like to keep the file.
	4. Name the file, add the appropriate extension.
	5. Click OK.
	6. To append an already existing file, locate and highlight the file name in the directory, then click OK. The file name will appear in grey. This denotes that the file name has been used before.

	Print & Export Format's
	Display in Fixed Field Format
	Display in Galley Format
	Display in ASCII Text File Format
	Display in Address Label Format
	

	Label Editor
	Where to Find the Label Editor
	
	1. To format labels, you must choose print or export from the Toolbar or File menu. Use the mouse to highlight Label from the format options.
	2. To view the Label Editor, click on the word Label in the lower left hand corner of the screen.
	3. The label editor will then be displayed. Use it to edit the label size and margins.
	How to Use the Label Editor

	Dial
	How to Dial
	1. Highlight the listing to be dialed.
	2. Click on the toolbar, or choose dial from the File menu.
	3. Click to configure your modem.
	How to Configure Modem
	1. You must set the following options before dialing.
	· Local Area Code: Enter your local area code. This indicates to the software which dial string it should use.
	· Local Prefixes: Enter the local prefixes for your area. Doing so indicates to the software which dialing string should be used.
	2. You must verify that the following options have defaulted to the appropriate settings.
	· Comport: The comport will default to Com1. If your system is connected to a different Comport, make that change in this box.
	· Dial: The default is ATTD (tone dial). In most cases you will need only use the default ATTD. However, should you need to change to ATPD (pulse dial), make that change in this box.
	3. The following options have defaults. You should not need to make any changes.
	· Local Dial String: The default is #. Based on the information that you entered into the local area code and local prefix fields, this dial string will be used if the number you are dialing is within your area code and prefix.
	· In Area Dial String: The default is: 1#. This string will be used if the number you are dialing is within your area code, but not in one of the local prefixes.
	· Out Of Area Dial String: The default is 1A#. This string will be used if the number you are dialing is not within your area code (or prefix).
	4. Click OK.

	Count
	How to Count
	1. Key in the search criterion.
	2. Click Max (our retriever) to initiate the search, or press Enter.
	3. Once the search has been initiated, press the Count button, or choose Count from the Search menu.
	4. A pop up window asking for you to indicate what entries you want to count will be displayed:
	5. Once you indicate what you actually want to count, click OK and WinPhone will count:

	Tag Manager
	How to Add Listings to the Tag Manager
	1. Listings are added to the Tag Manager from the Main Display Window.
	2. Highlight listing(s) that you want to add to the Tag Manager by clicking on them with the mouse.
	3. Using your mouse, click on the Tag button . Or double-click the highlighted listings. A tagged listing appears in Red.
	How to Remove Listings from the Tag Manager
	1. You must be in the Tag Manager window to remove a listing from the Tag Manager. Choose Tag Manager from the Window menu.
	2. Highlight the listing(s) that you want to remove from the tag Manager by clicking on them with your mouse.
	3. Using your mouse, click on the untag button . Or double-click highlighted listings. An untagged listing appears in black.

	How to Copy
	Copying Listings to the Clipboard
	1. Choose Copy from the Edit menu.
	2. The WinPhone Clipboard Copying dialog window will appear on the screen.

	µ §
	3. Set the appropriate parameters. You may copy either Highlighted Entries, Tagged Entries, or All Matching Entries. You may copy in any of the available formats: ASCII, Fixed, Galley or Label.
	
	4. Once you have indicated what you want to copy, and chosen the format you want to copy the listings in, click the OK button.
	5. The WinPhone Clipboard dialog box will indicate how many records were copied, and when the copy is completed.

	µ §
	6. You may then import the listings from the clipboard into any windows application.
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